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I. Introduction 

The Kapelle Series of Eartraining Applications 

The Kapelle series of eartraining applications are 32-bit Windows 

applications designed with one specific design philosophy: an 

eartraining application is best considered a tool and not a textbook. 

To that end, the Kapelle series applications avoid imposing a single, 

dogmatic point of view on the process of training the ear through 

listening, performance, and dictation exercises. The applications 

themselves do not generate materials on their own but instead 

depend on external files to provide them with examples. 

As a result, Kapelle applications are not restricted to any single 

syllabic or curricular requirement, but instead can be modified to be 

used in virtually any pedagogic environment. 

In addition to their philosophic similarity, the Kapelle programs also 

share more concrete elements: they are all based on the Apollo 

library for their underlying musical operation, and they share 

common interface and code elements wherever possible. As a 

result they are all similar in look and feel, facilitating the learning 

and use of the programs. 

A Description of Kapelle Intervals 

As the name would imply, Kapelle Intervals concentrates on 

eartraining via the study of intervals: writing intervals, hearing 

intervals, identifying intervals. 

Unlike most interval-training applications, Kapelle Intervals does 

not revolve around a single method of teaching intervals. 

Instead, Kapelle Intervals creates a series of intervals, and 

presents them to the user, according to the instructions in template 

files. The instructions in that template file can include the kinds of 

intervals, how they are constructed, in what manner they are 

performed, and how they are to be identified, heard, or written. 
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Each individual exercise is actually one such template file, and the 

number of template files which can be created and used with the 

program is unlimited. 

A full description of the various options available is given elsewhere 

in this manual. Suffice it to say that Kapelle Intervals can provide 

interval drill in virtually limitless variety, from the simplest of 

training for the beginner to highly challenging exercises for the 

advanced student. 

There are numerous methods used in teaching intervals; Kapelle 

Intervals can aid in almost all of them. Kapelle Intervals can 

present intervals in a variety of styles, including: 

• Completion styles: the interval is played with one note of the 

interval given. The student completes the interval by writing the 

missing note. 

• Identification styles: the interval is played and the student 

identifies the interval by size and quality. 

• Notational styles: the interval is played and the student writes 

in the notes that make up the interval. 

Some aspects of such styles as listed above can be combined. 

Among Kapelle Intervals’s other abilities include: 

• Use of harmonic or melodic intervals. 

• Selection of intervals by either scale degree or by interval types. 

• Use of all major and minor keys. 

• Use of all C clefs in addition to G and F clefs, including interval 

exercises which change clefs. 

• Addition of chromaticisms to intervals. 

• Compound intervals up to three octaves. 

The above lists are by no means exhaustive, but they do serve to 

give an idea of the application’s flexibility. 
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Kapelle Intervals is designed to be used as a teaching aid, and not 

an instructor in its own right. It does not give any information 

about intervals, for example, nor does it offer suggestions for 

improvement. It does evaluate the student’s work on a particular 

exercise (the method of evaluation being partially determined by 

the exercise template file) and does offer the student to compare 

the correct work on the interval (whether that be notation, 

identification, or some combination of those) with the work that 

was done. 

Like other Kapelle series programs, Kapelle Intervals keeps track of 

the user’s work in the program and stores progress reports which 

can be managed, filtered, exported, and printed. 

The Underlying Apollo Library 

Kapelle Intervals, like all applications in the Kapelle series, is 

supported by an underlying library named Apollo, from the same 

author, which provides musical notation and interface support. 

Not only are the two notational panes in the application powered by 

the Apollo library, but so is all of the MIDI-based musical playback, 

and certain other interface elements as well.  
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II. The Kapelle Intervals Window 

 

 

Figure 1: The Kapelle Intervals Window 

The Parts of the Window 

The Exercise Drive Pane 

The Exercise Drive Pane is a Windows tree-style control, in which 

files and/or directories are shown in the same hierarchical 

relationship as they are stored. 

Directories, which store exercises, are indicated with the folder 

icon. A plus (+) sign to the left of the folder indicates that the 

folder contains exercises. Expand the folder by clicking on the plus 

sign. 

Exercises are indicated with the square blue icon. All of the 

exercises which are available to you are accessible only via these 

Exercise Drive Pane 

Toolbar 

Status Bar 

Menu Bar 

Main Window 
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icons. You cannot open an exercise in Kapelle Intervals by double-

clicking on it from the Explorer. 

More information about these icons and the Exercise Drive Pane in 

general can be found in the section Understanding the Exercise 

Selection Pane on page 9. 

The Toolbar 

 

Figure 2: The Toolbar 

The Toolbar runs along the top of the main window by default, and 

contains icons for the most common commands used in the 

application. 

The Toolbar can be moved to any of the four borders of the 

window. Position the mouse cursor in any place on the Toolbar 

which is not occupied by an icon, and drag the mouse. 

If you release the mouse button before you have dragged the 

Toolbar to one of the four borders of the window, the Toolbar will 

become a floating palette. This floating palette can be moved by 

dragging its title bar, and can be resized by dragging it from any of 

its four sides or corners. 

The Status Bar 

 

Figure 3: The Status Bar 

The Status Bar runs along the bottom of the window. It contains an 

area for information about the currently selected command, as well 

as three other panes on the right which contain important 

information during an exercise in progress. Those three panes 

inform you about: 

• The current note position of the insertion caret. 

• The number of the current interval. 



Kapelle Intervals User Manual Page 6 

  

• The key of the current exercise. 

The Menu Bar 

The Menu Bar runs along the very top of the window, immediately 

below the title bar itself. The Menu Bar contains five menus: 

• The File Menu contains commands relating to open files, 

showing your progress report, setting program options, and 

exiting the application. 

• The View Menu contains commands for showing and hiding the 

Toolbar and the Status Bar. 

• The Interval Menu contains most of the commands you will use 

when notating and identifying an interval, as well as progressing 

through an exercise. 

• The Playback Menu contains all commands related to MIDI 

playback or MIDI settings. 

• The Help Menu contains commands for the online help system. 

The Main Window 

The Main Window is the place where most of the action occurs. 

When you first start Kapelle Intervals, the Main Window is empty 

except for the Instructions and Announcements Pane. However, as 

you progress through an exercise, the Main Window acquires 

various panes which display information, allow you to notate pitch, 

identify intervals, and show you the correct answers. 
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The Main Window Components 

 

 

Figure 4: Main Window Components 

Instructions and Announcements Pane 

The Instructions and Announcements Pane is the only pane in the 

Main Window which is always visible. When the program is first 

launched, or whenever there is not an exercise currently loaded 

into the application, it informs you to Select an exercise from 

the left side pane to begin. 

Thereafter, the Instructions and Announcements Pane will instruct 

you how to work your way through the exercise and will display 

your grade on the current interval, as well as provide you with a 

running cumulative score for the current exercise. 

Notation Input Pane 

The Notation Input Pane is used for inputting musical notation. The 

pane consists of a single staff and measure of musical notation, 

with a clef and (usually) a key signature. 

Instructions and Announcements Pane 

Notation Input Pane 

Interval ID Pane 

Comments Pane 

Notation Output Pane 

Interval ID Output Pane 
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Interval ID Pane 

The Interval ID Pane displays your identification of the current 

interval. It can also act like a control button if so desired: double-

clicking on the pane will bring up the Interval ID dialog box (as long 

as the current exercise style requires such an action, as well as 

other conditions being met.) 

Comments Pane 

The Comments Pane holds the text of a comment which has been 

saved along with the current exercise, by the author of that 

exercise. Generally speaking a comment will tell you information 

such as the following: 

• How many intervals are required to complete the exercise. 

• The style of the exercise. 

• Aspects of the exercise’s key, clefs, or other such information. 

Notation Output Pane 

The Notation Output Pane is displayed when the current interval 

has been identified. It allows you to compare the correct interval 

with the interval you notated (or identified). 

Interval ID Output Pane 

The Interval ID Output Pane displays the ID (size and quality) of 

the current interval. 



Kapelle Intervals User Manual Page 9 

  

III. Opening an Exercise 

Understanding the Exercise Selection Pane 

Opening Folders 

At least one folder, and usually more, will be located in the Exercise 

Selection Pane. 

 

Figure 5: A view of an Exercise Selection Pane 

Folders can appear in three different states: 

• Closed with files in them: the folder icon has a plus (+) sign to 

the left.  

• Closed without any files in them: there is no plus (+) sign to the 

left.  

• Open with files in them: the folder icon has changed to open, 

and you can see a list of files below the folder. Furthermore, the 

plus (+) sign has changed to a minus (-). 

 

To open a folder, click the mouse on the plus (+) sign. 

Selecting Exercises 

The exercises within a folder are identified with square blue icons. 

You may select the exercise for opening by clicking on the exercise 
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name. 

Opening an Exercise 

Opening An Exercise by Double-Clicking 

To open an exercise by double-clicking, simply position the mouse 

cursor over the exercise  (either its name or icon, it doesn’t matter) 

and double-click. 

Opening An Exercise From the File Menu 

To open an exercise by selecting a menu command, select the 

exercise by positioning the mouse cursor over the name or the icon 

of the exercise, and click once. Then select Open Exercise from 

the File Menu. 

Opening An Exercise With the Keyboard 

To open an exercise from the keyboard, first select the exercise by 

positioning the mouse pointer over the name or the icon of the 

exercise, and click once. Then press Control+O (the letter, not 

zero) to open the exercise. 

Opening An Exercise From the Context Menu 

To open an exercise by using the Context Menu, first select the 

exercise by positioning the mouse pointer over the name or the 

icon of the exercise, and click once. The click the alternate mouse 

button (almost always the right button), and select Open 

Exercise (the only command) from this menu. 

What an Exercise Actually Is 

Because an exercise consists of a series of intervals, you will 

probably think that the individual exercises contain the set of 

intervals that are used for the exercise. That would be a reasonable 

assumption, but it is incorrect. 

An exercise file is actually nothing more than a plain text file, quite 

similar to the INI files that were such a common feature in 
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Windows-based software prior to the introduction of Windows 95 

and Windows NT. Each line in the text file addresses one or another 

aspect of the exercise. Kapelle Intervals constructs the interval 

exercise based on the instructions in the exercise file. 

As a result, you may repeat an exercise as many times as you 

want, and it will not present precisely the same set of intervals 

each time—as would be the case were the exercise template file 

actually a listing of the intervals to play. Because the template file 

is a set of instructions, rather than a set of intervals, the actual 

outcome of the process which generates the set of intervals will be 

different each time the exercise file is opened, although the basic 

parameters of the exercise (the kinds of intervals generated, what 

keys they are in, and so forth) will remain those specified by the 

exercise file. 

Here is an example of the partial contents of an exercise file. This 

instructs Kapelle Intervals to create an exercise consisting of all 

thirds, using only the notes within the keys of C Major, or G Major, 

of F Major—depending on which key is chosen for the exercise. The 

exercise will use both ascending and descending intervals, and will 

not include any chromatic alterations. There will be 15 intervals in 

the exercise, which will always be notated in the alto clef. The 

exercise will be done with melodic intervals, in which you complete 

the interval with one note and identify it. 

useScaleDegrees=FALSE 

intervals=m3,M3 

clefs=alto 

clefsMix=FALSE 

modes=major 

useKeys=TRUE 

keysAll=FALSE 

keys=CM,GM,FM 

style=melCompID 

numInts=15 

ascend=TRUE 

descend=TRUE 

There are a very large number of combinations of options in a 

Kapelle Intervals exercise—the example given above shows only a 

subset of the possible instruction types and their values.  

Although it is possible to create a Kapelle Intervals by writing a text 

file from scratch and saving it with the proper extension (.kii), 

there is a utility program, IntervalMaker, available that makes the 

process much easier and much more reliable. 
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What Happens After You Open an Exercise 

Once you open the exercise, Kapelle Intervals goes to work and 

constructs the interval exercise based on the options given in the 

exercise template. 

In most instances, the time required to construct the exercise will 

be instantaneous from your point of view. In the case of large or 

unusually complicated exercises, there might be a slight delay as 

Kapelle Intervals works on the exercise. The length of this delay 

depends primarily on the speed of your computer. During this 

delay, the standard Windows “wait” cursor (usually an hourglass) is 

displayed. 

During the process the main window’s title bar will change to reflect 

the name of the new exercise, just like opening a document in an 

application. In fact, that’s precisely what you’re doing—opening a 

document in an application which, instead of showing you the 

contents of the document, goes industriously to work on making an 

interval exercise based on the contents of that document. 

As soon as the set of intervals has been constructed, Kapelle 

Intervals presents you with the first interval in the exercise. In 

most cases this will be accompanied by the playing of the first 

interval, provided this is a form of interval exercise in which the 

intervals are played by the program. (In some exercise styles, 

there is no playback—such as visual identification, in which you 

identify the interval by looking at it, and not by hearing it.) 
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IV. Working Your Way Through an Exercise 

You begin work on an interval exercise as soon as Kapelle Intervals 

has finished creating it. 

An interval exercise consists of a series of intervals; the exact 

number of intervals making up the exercise is determined by the 

exercise template. 

You work through the exercise one interval at a time. Although 

what you actually do with the exercise depends on the kind of 

interval exercise the exercise template has specified, the basic 

process is as follows: 

• Listen to the interval being played (if appropriate.) 

• Notate the interval (if appropriate.) 

• Identify the interval’s size and quality (if appropriate.) 

• Play the tonic triad as necessary, and play the tonic pitches 

themselves as necessary. 

• Tell Kapelle Intervals that the interval is ready for evaluation by 

using the Answer Ready command. 

• Observe the evaluation—your score, the correct interval and its 

identification—and play the correct interval and compare it to 

your version, as you wish. 

• Tell Kapelle Intervals to give you another interval by using the 

New Interval command. 

Once the exercise is complete, you can observe your overall 

progress by displaying the progress report, from which you can 

manage your accumulated scores, and print or export a textual 

progress report. 

The remainder of this chapter describes the basic operations in 

turn. 
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Requesting a New Interval 

Kapelle Intervals will present you with the first interval in the 

exercise automatically as soon as it finishes creating the exercise. 

Thereafter, however, you must ask the program to present you 

with new intervals. 

You may request a new interval only after you have completely 

finished with the current interval, including having given the 

Answer Ready command. 

The command to use is New Interval. You can access this 

command by any of the following techniques: 

• Select New Interval from the Interval Menu. 

• Select New Interval from the Context Menu (right click 

anywhere in the Main Window.) 

• Press Control+N. 

• Click on the New Interval icon  on the Toolbar. 

The Status Bar contains a pane which displays the number of the 

current interval within the set of intervals that makes up this 

exercise. This lets you know how many intervals you will still need 

to do before the exercise is finished. 

Determining the Interval Task 

Kapelle Intervals supports a wide variety of different exercise 

styles. These styles determine what kind of work you are required 

to do with an interval: you might be required to notate it, or 

identify it, or both. You might be asked just to notate an interval 

without hearing it. You might need to write both notes of the 

interval, or the first note may be given while you provide the 

second note. 

The Instructions and Announcements Pane will tell you what to do. 

For example, it might read: Write the interval below the given note, 
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then select Answer Ready (or press F5). 

Be sure to read the Comments Pane, which should contain 

information about the exercise in general. 

Kapelle Intervals will not allow you to do an interval task which is 

not required by the current exercise style. For example, if you are 

not required to identify the quality and size of the interval, the 

command Identify Interval will not be enabled. Or, if you are not 

required to notate the interval, none of the notation commands will 

be enabled. Playback is disabled for the purely-visual styles, and so 

forth. 

So, in general, remember that if you can do it, then you should. 

Determining the Key 

Most, but not all, exercises are notated in a major or minor key 

center. The name of the key can be found in the following 

locations: 

• In the Status Bar the rightmost pane will display the key name. 

If this is an exercise notated without a key center, the rightmost 

pane will read “No key center”. 

• The Play Tonic Pitches command displays the name of the key 

while the tonic pitches are being displayed onscreen. 

Playing the Interval 

Most exercise styles allow for playing the interval. (A few do not.) If 

playing the interval is allowable, the Play Interval command will 

be enabled. 

You may access the Play Interval command by any of the 

following techniques: 

• Select Play Interval from the Playback Menu. 
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• Press the spacebar. 

• Click on the Play Interval icon  on the Toolbar. 

See the chapter Playback, starting on page 29, for full information 

about interval playback. 

Notating the Interval 

Most exercise styles require some music notation—writing at least 

one note, and sometimes two. 

If notating the interval is germane to the exercise style, the 

commands for notating the interval will be enabled. Those 

commands include: 

• Enter Note 

• Delete Note 

• Sharp Note 

• Flat Nove 

• Move Note Up 

• Move Note Down 

Instead of going into great detail here (see the chapter Entering 

Notes, starting on page 21) the following is a quick summary of 

the techniques. 

Move the note-selection caret up and down, right and left (as 

applicable) using the arrow keys on your keyboard. 

If the Enter Note command is enabled, you may enter a note. The 

note will always be added to the end of the current measure—but 

the actual temporal location depends on the exercise style. 
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If a note can be edited (notes that are given as reference points are 

printed in red and cannot be edited), you can edit the note by 

placing the note-selection caret directly over the notehead (either 

by using the arrow keys or by clicking the mouse button) and then 

using editing commands Delete Note, Sharp Note, Flat Note, 

Move Note Up, and Move Note Down. 

Identifying the Interval 

Many exercise styles require that you identify the interval’s size and 

quality. To do that, use the Identify Interval command. 

If identifying the interval is germane to the exercise in question, 

the command will be enabled. If the command is not enabled (i.e., 

grayed out on menus and the Toolbar, no keyboard response) then 

either the current exercise does not require identifying the interval, 

or else this particular interval has already been evaluated and 

therefore cannot be identified again. 

When you give the Identify Interval command you will be 

presented with a small dialog box that allows you to select the 

interval quality from a drop-down list box. You may enter the size 

via a text box with a spin button control, allowing you to either 

type in the size directly or use the spin control to set it. 

The Identify Interval command may be accessed by any of the 

following techniques: 

• Select Identify Interval from the Interval Menu. 

• Select Identify Interval from the Context Menu (right-click 

anywhere in the Main Window.) 

• Click on the Identify Interval icon  on the Toolbar. 

• Press Control+I. 

For full information about identifying intervals, see the chapter 

Identifying Intervals, starting on page 27. 
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Playing the Tonic Triad 

Exercises which are notated in a key center allow you to play a 

tonic triad at any time. 

Use the Play Tonic Triad command for this purpose. You may 

access this command by any of the following techniques: 

• Select Play Tonic Triad from the Playback Menu. 

• Click on the Play Tonic Triad icon  on the Toolbar. 

• Press Control+T. 

For full information on playing the tonic triad, see the section 

Playing the Tonic Triad in the Playback chapter, starting on 

page 31. 

Playing the Tonic Pitches 

You may play the tonic pitches (i.e., ‘g’ in the key of G Major) at 

any time. The pitches will be displayed while they are sounding.  

Three tonic pitches are played: a relatively low tonic, then a tonic 

pitch one octave higher, then a tonic pitch one octave higher yet. 

The actual octaves used depends on the current clef; the tonic 

pitches are always kept within three leger lines of the current clef. 

In those exercises which are not notated in an identified key 

center, this command will play the note ‘c’ (do).  

Use the Play Tonic Pitches command for this purpose, which can 

be accessed by any of the following techniques: 

• Select Play Tonic Pitches from the Playback Menu. 

• Click on the Play Tonic Pitches icon  on the Toolbar. 
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• Press Control+H. 

For full information on playing the tonic pitches, see the section 

Playing the Tonic Pitches in the Playback chapter, starting on 

page 32. 

Signifying That Your Answer is Ready 

Once you have finished working with an interval, you tell Kapelle 

Intervals to evaluate it with the Answer Ready command. 

Kapelle Intervals will then evaluate your work, grade it, and allow 

you to examine your work on the interval. 

Your mark for the current interval, as well as a cumulative score for 

the entire exercise, will be displayed in the Instructions and 

Announcements Pane. 

You may access the Answer Ready command by any of the 

following techniques: 

• Select Answer Ready from the Interval Menu. 

• Select Answer Ready from the Context Menu (right-click 

anywhere in the Main Window). 

• Click on the Answer Ready icon  on the Toolbar. 

• Press F5. 

Comparing Your Answer to the Correct Answer 

After your interval has been evaluated, you will be allowed to 

compare your interval with the task interval.  

A new pane will be displayed to the right of the interval notation 

pane. This pane contains the interval you have heard (if you were 

playing the interval) and shows you the correct notation and the 

correct identification for the interval. 
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You can play your own version of the interval at this point by using 

the command Play My Interval. (This command is enabled for all 

exercise styles.) Access this command by any of the following 

techniques: 

• Select Play My Interval from the Playback Menu. 

• Click on the Play My Interval icon  on the Toolbar. 

• Press Control+Spacebar. 

Note that this command is not enabled until you have evaluated the 

interval by giving the Answer Ready command. 

For more information on this command, and playback issues in 

general, see the chapter Playback starting on page 29. 

When the Exercise is Over 

The exercise is over after you have signified Answer Ready for the 

last interval in the set. 

Once the exercise is complete, your score for the entire exercise is 

recorded into your progress report automatically. (If this score 

replaces an extant score for the same exercise, you will be asked if 

you wish to replace that score with this one.) 

Once the exercise is over, you can start a new exercise if you wish, 

or exit the program. 

If you use the Stop Exercise command to stop an exercise which 

has not ended normally, your score will not be recorded. 
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V. Entering Notes 

Basic Techniques for Note Entry 

Positioning the Caret 

The onscreen caret needs to be positioned both vertically (for pitch) 

and horizontally (for rhythm.) The vertical position of the caret 

determines which note will be entered onto the screen: the caret 

can be positioned on any line or space on the staff. The horizontal 

position determines whether you notate the first or second note of 

the interval (if the interval is melodic.) 

In many kinds of interval exercises, you do not need to concern 

yourself with the horizontal aspect of the onscreen caret. This is the 

case under the following styles of exercises: 

• Completion styles: in a completion style you are writing in only 

one note to finish the interval, the first note of the interval being 

given. Kapelle Intervals will ensure that the note is added 

correctly: for harmonic intervals, the note will be entered at the 

same location as the given note, and for melodic intervals, the 

note will be entered after the given note. 

• Harmonic intervals: in harmonic intervals the two notes of the 

intervals sound simultaneously. Therefore the notes you enter 

are always at the same time, so the caret will not respond to 

horizontal motion. 

• Writing an interval: writing an interval is very similar to a 

completion style in that you are given the first note and provide 

the second one. Kapelle Intervals will ensure that the note you 

write will be placed after the given note. 

• Identification-only styles: here there is no notation component, 

so horizontal caret motion is ignored. 

Pitch 

The caret moves vertically to determine pitch. 
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Mouse 

To move the caret vertically with the mouse, simply click on a line 

or space and the caret will jump automatically to that location. 

Keyboard 

The caret is moved with the Up Arrow and Down Arrow keys on 

your keyboard. If you press and hold either key, the caret will 

move continuously. 

Time 

Mouse 

To move the caret horizontally with the mouse, click at the 

approximate horizontal location you would like the caret to appear. 

Note, however, that the caret will jump horizontally only to a 

location where a note is already placed—thus it cannot be placed 

anywhere but on the first or second notes of an interval. 

In harmonic interval exercises, the caret does not move 

horizontally. The same is true of exercises in which the notational 

element is absent. 

Keyboard 

The Left Arrow moves the caret over to the first note position if it is 

currently positioned at the second note position. 

The Right Arrow moves the caret over to the second note position if 

it is currently positioned at the first note position, and if there is a 

note at the second note position. 

In harmonic interval exercises, the caret does not move 

horizontally. The same is true of exercises in which the notational 

element is absent. 

Entering the Note 

It is very easy to enter a note in Kapelle Intervals. You simply 
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position the caret where you want the note to appear, and use the 

Enter Note command to add the note. 

The Enter Note command adds the note to the end of the current 

measure—but it does not allow more than two whole notes to exist 

in the measure at any time. 

Therefore, if there are two notes in the measure, the Enter Note 

command is disabled (grayed-out). 

If you need to change a note you have entered, then you use the 

Delete Note to remove it and then Enter Note to add a note, or 

else use the Move Note Up and Move Note Down commands to 

alter the note. 

The Location of Note Entry Commands 

You may access the Enter Note command by any of the following 

techniques: 

• Select Enter Note from the Interval Menu. 

• Select Enter Note from the Context Menu (right-click anywhere 

in the Main Window.) 

• Click on the Enter Note icon  on the Toolbar. 

• Press the Enter key. (This is usually the fastest, and most 

convenient, way to access this command.) 
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VI. Editing Notes 

Kapelle Intervals allows you to edit a note you have entered. You 

may change the line or space on which the note is located, you 

may add or subtract accidentals, and you may delete the note. 

Selecting a Note for Editing 

A note is selected for editing if the onscreen caret is positioned 

directly over the notehead. 

You will know that the note is selected for editing because the 

various note editing commands will become enabled. You can see 

this most clearly on the Toolbar: grayed-out icons suddenly acquire 

colors. 

Locked Notes versus Unlocked Notes 

Kapelle Intervals is sometimes required to insert a “given” note into 

your notational area. Usually this is the first note of an interval; 

you complete the interval by notating the second note. If you are 

identifying an interval visually, both notes might be “given” notes. 

A “given” note cannot be edited or deleted, of course. The note is 

locked when it is the “given” note. Therefore, selecting a locked 

note for editing will not result in the editing commands becoming 

enabled.  

A locked note is drawn in red, instead of black. 

Deleting Notes 

In order to delete a note, select it and then use the Delete Note 

command. You may access this command by any of the following 

techniques: 

• Select Delete Note from the Interval Menu. 
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• Select Delete Note from the Context Menu (right-click 

anywhere in the Main Window.) 

• Click on the Delete Note icon  on the Toolbar. 

• Press the Backspace key. 

Moving Notes 

You may move a note to a new line or space. To do this, use the 

Move Note Up and Move Note Down commands. Each command 

moves the note one line or space up or down. 

You may access the Move Note Up/Down commands by any of 

the following techniques: 

• Select Move Note Up or Move Note Down from the Interval 

Menu. 

• Select Move Note Up or Move Note Down from the Context 

Menu (right-click anywhere in the Main Window.) 

• Click on the Move Note Up or Move Note Down icons 

on the Toolbar. 

• Press Control+Up Arrow or Control+Down Arrow to access 

Move Note Up or Move Note Down, respectively. 

• Press Control and move the mouse upwards or downwards—

the note will move on the screen in response. 

Adding Accidentals to Notes 

You may add sharps (up to the double-sharp) or flats (down to the 

double-flat) to notes, by using the Sharp Note or Flat Note 

commands. 

Note that Kapelle Intervals treats accidentals in the traditional 

manner—that is, an accidental applied to a line or space on the clef 

applies to notes positioned on that same line or space afterwards 
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during the measure. 

You may access the Sharp/Flat Note commands by any of the 

following techniques: 

• Select Sharp Note or Flat Note from the Interval Menu. 

• Select Sharp Note or Flat Note from the Context Menu (right-

click anywhere in the Main Window.) 

• Click on the Sharp Note or Flat Note icons on the 

Toolbar. 

• Press F7 or F8 to access Move Note Up or Move Note Down, 

respectively. 
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VII. Identifying Intervals 

Identifying an interval means to specify its size and quality. In 

many exercise styles, you are required to identify the interval as 

part of the drill process. 

You identify an interval with the Identify Interval command. You 

may access this command by any of the following techniques: 

• Select Identify Interval from the Interval Menu. 

• Select Identify Interval from the Context Menu (right-click 

anywhere in the Main Window.) 

• Double-click on the Interval ID pane in the Main Window. 

• Click on the Identify Interval icon  on the Toolbar. 

• Press Control+I. (That’s the letter ‘I’). 

Using the Interval Identify Dialog Box 

You identify an interval through the Identify Interval Dialog Box. 

 

Figure 6: Identify Interval Dialog Box 

This dialog has two components: a drop-down list box for 

identifying the Quality, and a numerical-entry box (with a spin 

control) for identifying the interval’s size. 

To Identify the Quality 

To identify the quality, click on the small downward-pointing arrow 

on the Quality drop-down list box, and then select a quality from 

the list of possibilities (note that the list has a scrollbar!). 
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Figure 7: Selecting a Quality 

To Identify the Size 

To identify the size, click in the Size number-entry box and either: 

• Type in the size (1, 2, 12, etc.) 

• OR use the spin button control to increase the size by 

increments either upwards or downwards. 

Using the Keyboard for Speedier Entry 

You might find it much faster to use the keyboard to identify the 

interval. Here is a very quick way to do it: 

• Identify the quality first: the Quality control is automatically 

selected when the dialog box opens. Type the first letter of the 

quality of the interval—M for major or minor, D for diminished 

or doubly diminished, etc. Retype the letter as you need to cycle 

through the choices. (For minor you would type M twice—the 

first time it selects Major, and then the second time it selects 

Minor.) 

• Use the Tab key to select the Size number-entry box, and then 

type in the size. 

• Press Enter to click the OK button. 
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VIII. Playback 

Most exercise styles involve playback of the current interval. When 

the interval is first presented, the interval is played automatically 

(provided the exercise style requires playback.) But you may play it 

again if you wish. 

Playing the Interval 

To play the interval, use the Play Interval command. You may 

access this command by any of the following techniques: 

• Select Play Interval from the Playback Menu. 

• Click on the Play Interval icon  on the Toolbar. 

• Press the Spacebar. 

Playing Your Notated Interval 

After the current interval has been evaluated, you may play your 

notated version of the interval in order to compare your work with 

the interval that was given. (This will even work in the “write” 

exercise style, which does not involve aural identification.) 

To play your notated interval, use the Play My Interval command. 

You may access this command by any of the following techniques: 

• Select Play My Interval from the Playback Menu. 

• Click on the Play My Interval icon  on the Toolbar. 

• Press Control+Spacebar. 
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Setting the Tempo for Interval Playback 

You may wish to adjust the tempo of playback for melodic 

intervals. The default speed is 120 beats per minute, which might 

sound fast but you should keep in mind that the basic note value is 

the whole note—thus this means two seconds per note. 

The playback tempo is adjustable anywhere from 1 to 255 beats 

per minute. To adjust the tempo, use the Tempo command. You 

may access this command by any of the following techniques: 

• Select Tempo… from the Playback Menu. 

• Press Control+E. 

This command produces the Tempo Dialog Box. 

 

Figure 8: Tempo Dialog Box 

You may use the three pre-defined tempi (slow, medium, and fast) 

or you may provide your own custom tempo by clicking on the “Set 

Custom” button. This will produce the Set Tempo dialog box. Use 

the slider control to select a tempo anywhere from 1 to 255 beats 

per minute, and then click OK. 

 

Figure 9: Set Tempo Dialog Box 

NOTE: this setting is saved when you exit the program, so Kapelle 

Intervals will remember it thereafter. 
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Playing the Tonic Triad 

If an exercise has selected its intervals from a key center—and is 

therefore notated in a key center—you may play the tonic triad for 

reference at any time. 

Use the Play Tonic Triad command for this purpose. You may 

access this command by any of the following techniques: 

• Select Play Tonic Triad from the Playback Menu. 

• Click the Play Tonic Triad icon  on the Toolbar. 

• Press Control+T. 

Setting the Duration of the Tonic Triad 

By default, the tonic triad sounds for a duration of two seconds. 

You may adjust the duration by using the Tonic Triad Length 

property page of the Options property sheet. 

To access the Options Property Sheet: 

• Select Options from the File Menu, then click on the Tonic 

Triad Length tab. 

The Tonic Triad Length property page allows you to set the tonic 

triad playback length any where from one-half to five seconds, by 

either using the slider control or selecting one of the pre-defined 

settings. 

 

Figure 10: Tonic Triad Length property page 
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This setting is saved when you exist the program, so Kapelle 

Intervals will remember it thereafter. 

Playing the Tonic Pitches 

If an exercise has been notated in a key center, you may play tonic 

pitches for reference points. 

To access the Play Tonic Pitches command, use any of the 

following techniques: 

• Select Play Tonic Pitches from the Playback Menu. 

• Click the Play Tonic Pitches icon  on the Toolbar. 

• Press Control+H. 

About the “Tonic Pitches” 

The “tonic pitches” are three tonic notes which are centered around 

the current clef. Kapelle Intervals makes sure that the three tonic 

pitches it plays stay within three leger lines of the current clef. 

The tonic pitches are played in low-to-high order, one after 

another. While they are being played, they are displayed to you in 

a small dialog box that appears during the playback. 

 

Figure 11: Tonic Pitch Playback dialog 

The note that is currently sounding will be drawn in red. 

The pitches are drawn in the current clef. The current key is 

indicated.  

Note that the pitches are drawn with accidentals and not with a key 
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signature. Here is an example: 

 

Figure 12: Tonic Pitch Playback dialog in D-Sharp Minor and Tenor Clef 

Setting the Speed of the Tonic Pitches 

The tonic pitches default to playing with each note lasting one 

second. You may adjust the duration by using the Tonic Pitches 

Speed property page in the Options property sheet. 

You may access the Options property sheet by: 

• Selecting Options… from the File Menu, and then clicking on 

the Tonic Pitch Speed tab. 

 

Figure 13: Tonic Pitch Speed property page 

Use the slider control to set the duration from 0.5 seconds to 5 

seconds, or select one of the pre-defined durations. 

This setting is saved when you exit the program, so Kapelle 

Intervals will remember it thereafter. 
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IX. Stopping an Exercise 

An exercise’s final score is the accumulated percentage of your 

work with the intervals. 

The final score is the only one that is actually saved in a progress 

report. The final score is written to the progress report only when 

the exercise stops normally—that is, you have given Answer 

Ready on the last interval in the exercise. 

Stopping Automatically 

The exercise stops automatically when you have answered every 

interval in the exercise. The end of the exercise will be announced 

in the Announcements and Instructions pane: 

 

Figure 14: End-of-Exercise Announcement 

Stopping Before the Exercise is Complete 

You may stop an exercise before it has ended normally, but your 

final score will not be saved if you do so. 

To stop an exercise prematurely, use the Stop Exercise command. 

You may access this command by any of the following techniques: 

• Select Stop Exercise from the Interval Menu. 

• Select Stop Exercise from the Context Menu (right-click 

anywhere in the Main Window.) 

• Click the Stop Exercise icon  on the Toolbar. 

You will always be asked to confirm this step, since it is non-

retractable and essentially throws out whatever work you have 

done on the current exercise: 



Kapelle Intervals User Manual Page 35 

  

 

Figure 15: Stop Exercise confirmation 
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X. Evaluations 

As you work your way through an interval exercise, your work is 

evaluated. Once you have completed the exercise, the accumulated 

evaluation is recorded into your progress report. 

Kapelle Intervals evaluates your work based on the following: 

• The correctness of the musical notation (as necessary). 

• The correctness of your identification of the interval (as 

necessary). 

When you signify that you are ready to have your work on an 

interval evaluated with the Answer Ready command, Kapelle 

Intervals grades the interval. The score is given as a percentage, 

based on the number of elements you were required to provide. 

Interval identification is always worth 2 points: one for the size, 

and one for the quality. 

Notation is worth one or two points, depending on whether you 

were asked to notate one of the notes (completion) or both of 

them. 

Once Kapelle Intervals has evaluated the interval, it displays your 

current grade for the interval, your accumulated score for the 

entire exercise so far, and also allows you to see and hear the 

interval you were identifying (or writing.) 

The current and accumulated scores are placed in the Instructions 

and Announcements pane, while the source interval is shown in its 

own pane: 
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Figure 16: Example of an evaluated interval 

In the above example, the identification was correct, but the 

notation was incorrect: the upper note should have been an A-flat, 

and not a B-flat. Therefore the grade for this interval was 66.67%. 

Enharmonic Considerations 

Certain kinds of interval exercises can involve a great deal of 

enharmonic notes and identifications.  

Whether or not an enharmonically-equivalent note (or 

identification) is accept as correct by Kapelle Intervals depends 

upon the instructions in the exercise template. 

To be precise, the template specifies the following aspects of 

evaluating enharmonics: 

• Whether or not to allow an enharmonically-equivalent note to be 

considered correct. 

• Whether or not to allow an enharmonically-equivalent 

identification (such as augmented fourth instead of diminished 

fifth) to be considered correct. 

• If enharmonically-equivalent identifications are allowed, whether 

or not to require that the notation match the enharmonic 

identification for the interval to be considered correct. (For 

example: if an interval is identified as an augmented fourth, but 

written as a diminished fifth.) 
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XI. Progress Reports 

Accessing Your Progress Report 

To access your progress report, use the Show Progress Report 

command. You may access this command by any of the following 

techniques: 

• Select Show Progress Report from the File Menu. 

• Click the Show Progress Report icon  on the Toolbar. 

• Press Control+P. 

The Contents of Your Progress Report 

A progress report is a special file created for you automatically by 

Kapelle Intervals the first time you used the application. It contains 

a record of all of the exercises you have performed, together with 

their scores, and the date/time when you did each individual 

exercise. 

The progress report is shown in a special dialog box which allows 

you to manipulate the contents of your progress report: you can 

delete entries, sort the report by various criteria, filter out entries, 

as well as print or export your progress report as a text file. 
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Understanding the Progress Report Window 

 

Figure 17: The Progress Report Window 

The main area of the progress report window is devoted to a list 

box which displays each entry in the progress report. Each entry 

represents a single exercise, and each entry contains the following 

fields: 

• Name: the file name for this exercise. 

• Grade: the score you received for your work. 

• Date: the date and time you received this particular score. 

Sorting Entries 

You may sort the entries by any of the three fields—Name, Grade, 

and Date. Sort them by clicking on the field header: 

 

Figure 18: Sorting Entries by Date 
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Selecting Entries 

To select an entry, click on the Name field for that entry: 

 

Figure 19: Selecting an entry 

To select an inclusive range of entry, click on the Name field for the 

first entry in the range, and then hold down the Shift key and click 

on the Date field for the last entry in the range: 

 

Figure 20: Selecting an inclusive range of entries 

To select multiple, non-continguous entries, hold down the Control 

key and click on each entry you wish to select: 

 

Figure 21: Selecting non-contiguous entries 

Deleting Entries 

To delete an entry, select the entry or entries you wish to delete 

(see the above section on selection techniques) and then click on 

the “Delete Item” button on the top of the window: 

 

Figure 22: Deleting entries 
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NOTE: the item will not be permanently deleted unless you click on 

the “Save/Close” button, which saves the changes you have made 

in your progress report. If you click on the “Close” button instead, 

you will be given the option to close your report without saving 

changes. 

Filtering Entries 

You may filter the entries in the progress window—that is, include 

only those entries which you want to see. This feature can be very 

useful if you are printing a progress report since reports can grow 

very long quickly. You may filter by Date, by Clef, by Level, or by 

Score. 

Note that filtering does not remove the items from your 

Progress Report: it determines how they are displayed and 

printed only; the contents of the actual file remain 

unchanged. 

To reach the filters, click on the “Filter” button: 

 

Figure 23: Location of the Progress Report buttons 

You will be presented with the Filters property sheet, which is a 

“tabbed” dialog box—each tab controls one specific filter. Go to 

each property page by clicking on its tab: 

 

Figure 24: The Filters property sheet 

Filter by Date 

You may filter entries to those occurring within a specific time 

frame, measured from the present: 
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Figure 25: Filter by Date Property Page 

To select an option, click on the radio button that selects that filter, 

and then select a range of options. In this illustration, only those 

exercises which have been done within the last 3 days will be 

displayed: 

 

Figure 26: A sample filter 

Date filters operate up to a year in the past—you may show those 

entries created up the last 365 days, or the last 52 weeks, or the 

last 12 months. 

Filter by Exercise 

You may restrict the display to only those exercises you choose: 

 

Figure 27: Filter by exercises property page 

Select exercises to be displayed by clicking on the check box to the 

left of the exercise. Checked exercises are displayed, unchecked 

ones are not. Note that you may select or deselect all of the items 

quickly by using the Select All and Clear All buttons. 
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Filter by Grade 

Finally, you may restrict your display to just those exercises that 

fall within a range of scores: 

 

Figure 28: The Filter by Score Property Page 

Removing Filters 

If you have filtered your progress report, you may remove the 

filters by clicking on the “Remove Filters” button at the top of the 

Progress Report window: 

 

Figure 29: Location of the Remove Filters button 

NOTE: the “Remove Filters” button is activated only if you have 

filtered your progress report. 

Printing Your Progress Report 

To print your progress report, click the “Print” button: 

 

Figure 30: Location of the Print button 

If you have filtered your progress report, you will be asked if you 

want to print the filtered set of records, or the entire report: 

 

Figure 31: Printing a filtered report 

Printing will then proceed.  
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NOTE: Kapelle Intervals uses WordPad, which is installed 

automatically along with Windows, for printing. If WordPad is not 

installed, an error message will result and you will not be able to 

print. 

Exporting Your Progress Report 

You may export your progress report to a plain-text, tab-delimited 

file, suitable for importing into a spreadsheet or database 

application. 

To export your progress report, click on the “Export” button. You 

are presented with a standard Windows Save As dialog box: 

 

Figure 32: Save As dialog box 

Kapelle Intervals offers a default name for your progress report; 

you may change this to suit yourself. Use the Save As dialog box to 

navigate to the location where you want to save the exported 

progress report, then click Save. 

NOTE: an exported progress report is always the complete set of 

entries, whether or not the report has been filtered. 

Closing the Progress Report Dialog Box 

To close the Progress Report dialog box, click either Save/Close or 

the Close button. Save/Close will automatically save changes you 

have made, and then close the dialog box. 

Clicking on the Close button will give you the option of saving any 

changes you may have made prior to closing the dialog box: 
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Figure 33: Closing the Progress Report 

Note that any changes you have made—sorting, filtering, deleting—

are not saved permanently to the progress report file unless you 

specifically indicate that the changes are to be saved, either by 

clicking the Save/Close button, or by clicking on Close and then 

clicking “Yes” in response to the query about saving your changes. 
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XII. Saving and Restoring Your Place 

You might need to pause for a while when working through an 

exercise and come back to it later. For that purpose, Kapelle 

Intervals allows you to save and restore your place in an exercise. 

Saving Your Place in an Exercise 

To save your place in an exercise, select Save Your Place… from 

the File Menu. 

An information box will tell you what you are about to do: 

 

Figure 34: Save Your Place Information Dialog 

The critical information here is that the current exercise will be 

removed once you have saved your place—in other words, you 

cannot save your place and just continue working on the exercise. 

Click Yes (or press Enter) to confirm this action, or No if you 

would rather not. 

Restoring Your Place in an Exercise 

If you have saved your place in any exercises previously, the 

Return to Your Place… command on the File Menu will be 

enabled. 

To return to your place in a previous exercise, give this command. 

The following informative dialog box will be presented: 
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Figure 35: Return to Your Place Information Dialog 

The critical issue here is that the current exercise will be closed if 

you restore a previous exercise. Click Yes if this is all right with 

you, or No if you would rather not restore an exercise right now. 

If you have saved your placed in only one exercise previously, the 

restoration will happen immediately upon clicking Yes. 

However, if there are multiple saved exercises available, Kapelle 

Intervals will present you with a list from which you can choose: 

 

Figure 36: Choose Exercise State File Dialog Box 

The name of the “Exercise State File” reflects the following 

information: 

• The name of the exercise. 

• The date on which you saved your place in this 

exercise. 

• The time at which you saved your place in this 

exercise. (The time format is hhmmssAM/PM—so it 

might be a bit tricky to read). 

Select the exercise you wish to restore, and click OK. 

NOTE: you can restore your place in an exercise only 

once. Once it has been restored, the exercise state file 

that contained the information is automatically deleted. 

You may, of course, save your place again. 
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NOTE: the “restored” exercise may not contain precisely 

the same scales as the one you saved. The actual 

notation material itself is not saved when you save your place—just 

the information about where you were in a particular exercise, the 

exercise to create, and your scores. Restoring your place generates 

a new exercise from the same template as previously, and sets up 

your place and scores in the exercise to match that when you 

saved your place. 
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XIII. MIDI Playback Settings 

The MIDI Settings Dialog Box 

Kapelle Intervals’s MIDI Settings are all reached via the MIDI 

Settings dialog box. Use this dialog box to set input and output 

ports, output channels, output programs, and the MIDI Thru 

feature. 

To adjust your MIDI settings, use the Midi Settings command, 

located on the Playback Menu. 

The MIDI Settings dialog box is displayed: 

 

Figure 37: MIDI Settings dialog box 

Setting the MIDI Input and Output Ports 

To set your MIDI Input and Output ports, use the list boxes in the 

MIDI Settings dialog box. Both of these will allow you to choose 

from available devices on your system: 

 

Figure 38: MIDI Input and Output ports 

NOTE: most systems will have only one MIDI Input port, but may 

well have several output ports. 

NOTE: Kapelle Intervals does not make any overt use of MIDI 

Input. 



Kapelle Intervals User Manual Page 50 

  

Setting Output Channels 

The MIDI Output Channel determines which of the standard 16 

MIDI channels Kapelle Intervals uses for MIDI output. Kapelle 

Intervals’s playback is always through one single MIDI channel. Use 

the Channel slider to select a value between 1 and 16: 

 

Figure 39: MIDI Output Channel selector 

Setting Output Programs 

Kapelle Intervals will set your MIDI device to play using any one of 

its available programs, from 1 through 256. You may use the slider 

to set the program, or you may select the output by name.  

 

Figure 40: Output program slider 

To select the MIDI program by name, click on the Select By Name 

button. This presents you with the Select Program dialog box: 

 

Figure 41: Select Program dialog box 

Select an instrument from the Instrument drop down list, then 

select a program from the list of available programs by clicking on 

the program name and then clicking on the OK button (or double-

click on the program’s name). 

Setting MIDI Thru 

MIDI Thru allows you to route the output of your MIDI instrument 

to the input of a MIDI playback device (such as the internal sound 
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card on your computer.) You may select which channel receives the 

routed output information by using the slider. 

 

Figure 42: MIDI Thru controls 

Use the MIDI Thru channel slider to set the channel. Make sure that 

the MIDI Thru check box is checked for MIDI Thru to be enabled. 
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XIV. Setting the Screen Colors 

The Parts of the Screen With User-Set Color 

Most of the screen elements in the Main Window contain user-

adjustable color. These are: 

• The background color for the entire window. 

• The background color for the two music notation panes. 

• The color for user-side and answer-side music notation. 

• The background color for the user-side feedback panes. 

• The text color for the user-side feedback panes. 

• The background color for the answer-side feedback panes. 

• The text color for the answer-side feedback panes. 

Using the Colors Property Page 

You may access the Colors property page by selecting Options… 

from the File Menu. The Colors property page is the first page on in 

the Options property sheet. 

 

Figure 43: Colors property page 
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To change the color of a screen element, first select that screen element, then click on the 

Change Color… button. 

Clicking on Screen Elements to Select Them 

You may select a screen element simply by clicking on it. The 

screen elements list box will change to reflect the screen element 

you have clicked. 

Double-Clicking on Screen Elements 

If you double-click on a screen element, this will select it and then 

click the Change Color… button for you automatically. 

Using the Screen Elements List Box 

You may also click on the screen elements drop-down list box to 

select a screen element. 

 

Figure 44: Screen elements selection 

Immediately to the right of the screen elements drop-down list box 

a color swatch for the element’s current color. As you select 

different screen elements, you will notice that this color swatch 

changes color. 

Clicking on the Change Color… button produces the standard 

Windows color selection dialog box, from which you may choose 

any color supported by your video system. 

Click on the Default button to return the color of the currently-

selected screen element to its default color. 

Click on the Default All button to return the colors of all elements 

to their default colors. 

The Default Colors 

The default colors used for screen elements are as follows: 
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Figure 45: Default Colors 

• User bands: dark blue 

• User bands text: white 

• Source bands: dark red 

• Source bands text: white 

• User and source notation backgrounds: white 

• User and source notation: black 

• Background: light gray 

A Few Considerations 

• Locked notes (the “given” note when apropos) are always drawn 

in red, no matter what color you’ve chosen for the rest of the 

notation. 

• Feel free to have fun with colors, and don’t hesitate to use the 

Default All button to return the screen to its normal, subdued 

colors if things get out of hand. 

• Remember that these settings are saved when you exit the 

program, so you don’t have to reset them every time. 
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XV. Online Help 

Kapelle Intervals offers a large online help system which can help 

you in learning to use the program effectively. 

There are two ways to access the Help system: one by using the 

Help Topics command on the Help Menu, and the other to use the 

context-sensitive help. 

Using Context-Sensitive Help 

To activate context-sensitive help, use one of the following 

techniques: 

• Press Shift+F1, and then click on the screen item (or select the 

item from the menu) that you wish help on. 

• Click on the Context Help icon  on the Toolbar, and then 

click on the screen item (or select the item from the menu) that 

you wish help on. 

Using the Online Help System 

To use the online help system, select Help Topics from the Help 

Menu. This will produce the Table of Contents for the help system: 

 

Figure 46: Online Help Table of Contents 
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The help topics are arranged in books: double-click on a book title 

to expand it and see the topics contained. 
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XVI. Types of Exercises 

Interval Styles 

Melodic Intervals 

Melodic intervals consist of two notes played in succession. In 

Kapelle Intervals, these notes are always notated as whole notes. 

Harmonic Intervals 

Harmonic intervals consist of two notes played simultaneously. In 

Kapelle Intervals, these notes are always notated as whole notes. 

Method of Assembling Exercise Intervals 

Intervals Chosen by Scale Degree 

Choosing intervals by scale degree restricts the notes used in the 

intervals to certain degrees of the scale. The scale degrees are 

given in pairs, for example 3:5—the first note in the interval is the 

third scale degree and the second note is the fifth scale degree. 

Selecting intervals by scale degree does not limit the intervals to 

certain sizes or qualities. For example, selecting intervals on the 

basis of scale degrees 3:5 would result in an ascending minor third 

but could also result in a descending major sixth. 

The scale degrees used may also be altered chromatically, 

depending on the instructions in the template. 

Intervals Chosen by Interval Type 

Choosing intervals by interval type means to restrict the selection 

to certain intervals and qualities—for example, only major 3rds and 

minor 3rds. 

The chosen intervals may be selected within the boundaries of a 

key center or not as the template requires. In addition, chromatic 
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alterations may be made to the notes of the intervals in a variety of 

ways, depending on the instructions contained in a particular 

template. 

Number of Intervals in an Exercise 

Kapelle Intervals puts no restrictions on the number of intervals 

that constitute one instance of an exercise—that is, the number of 

intervals you must complete before the program evaluates your 

work. 

Compound Intervals 

A compound interval is an interval which is larger than an octave. 

Kapelle Intervals allows for intervals to be created up to three 

octaves in span, where possible. The exercise template may or may 

not specify the use of compound intervals. 

Compound intervals may be one or two octaves larger than the 

original octave, depending on the instructions in the template. 

Exercises may mix compound intervals with non-compound ones, 

or may be exclusively all compound intervals—or, of course, may 

contain no compound intervals at all. 

Interval Direction 

Exercises may be all ascending intervals, or all descending 

intervals, or may mix the two. 

Key Centers 

Intervals may be selected from a set which is derived from a key 

center, or they may be selected from a set of all possible intervals 

without regard to key center. 

When intervals are selected from a key center set, there are 

embellishments and restrictions that can be made, likewise with 

those intervals which are selected from the set of all possible 

intervals. 
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Intervals Part of a Key Center 

If an exercise selects its intervals from a key center, the entire 

exercise will remain in that key throughout its duration. 

Selected Keys 

The intervals may be selected from a specific list of keys, such as C 

Major, E Minor, of C# Major. (Kapelle Intervals understands major 

and minor modes only.) 

Unrestricted Keys 

The intervals may also be selected from any of the 30 major and 

minor keys, at random. 

However, the exercise template may have restricted the selection 

as to mode. 

Selected Modes 

The exercise template may specify that the intervals be drawn only 

from major mode, or only from minor mode. 

Unrestricted Modes 

The exercise template may not specify any modal restrictions, thus 

any of the 30 major and minor keys may be chosen at random. 

Chromatic Alterations 

It is possible for the template to specify that certain scale degrees 

within the key center may be chromatically altered, and by a 

certain direction and amount. For example, the template may 

specify that the 3rd scale degree may be raised by one half-step, or 

lowered by two half-steps. 

If a scale step may be chromatically altered, that is no guarantee 

that it will be chromatically altered. 
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Intervals Without Key Center 

Intervals may also be chosen without a key center as guidance. (In 

such circumstances the intervals are chosen by interval type 

instead of scale degrees, obviously.) 

When intervals are chosen this freely, it is possible for some very 

unusual interval spellings to be allowable. Therefore, the exercise 

template may restrict the usage of some accidentals. 

Allowed Accidentals 

It is possible for the exercise template to forbid the use of sharps, 

flats, doublesharps, or doubleflats, singly or in combination. 

Clefs 

Kapelle Intervals can work in any of the standard clefs: not just 

bass and treble, but also all the C clefs as well. An exercise may 

use any of the following clefs: treble, soprano, mezzo-soprano, 

alto, tenor, baritone (c), baritone (f), and bass. 

Intervals Presented in One Clef Only 

An exercise may be presented throughout in a single clef, chosen 

from the instructions in the template. 

Intervals Presented in Multiple Clefs 

An exercise may present the intervals in clefs drawn at random 

from a list of clefs in the exercise template. Each new interval can 

be in a different clef from the one previous. 

Exercise Styles 

Kapelle Intervals supports 12 different exercise styles, or methods 

of working with intervals. These styles can be thought of as 

belonging to various categories: for example, completion styles are 

those in which the first note of the interval is given, and the second 

note has to be provided after listening. Kapelle Intervals supports 

both harmonic and melodic intervals. 



Kapelle Intervals User Manual Page 61 

  

The following is a description of the various categories of styles. 

Basic Styles 

Completion 

In a completion style, the first note of the interval is given and the 

interval is played. The second note must be provided in order to 

complete the interval. 

Notation 

In a notation style, the interval is played. Both notes of the interval 

must be provided in order to complete it. 

Identification 

In an identification style, the size and quality of the interval must 

be given in order to complete it; there is no notation. 

Combined Styles 

Completion with Identification 

In this style, the interval is played and the first note is given. The 

second note must be provided and the interval identified in order to 

complete the interval. 

Notation with Identification 

In this style, the interval is played. Both notes of the interval must 

be provided and the interval must be identified in order to complete 

it. 

Listing of All Exercise Styles 

Melodic Completion 

Two notes are played sequentially. The first note is given. The 

second note must be provided. 

Melodic Completion with Identification 

Two notes are played sequentially. The first note is given. The 

second note must be provided and the interval identified. 
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Melodic Notation 

Two notes are played sequentially. Both notes must be provided. 

Melodic Notation with Identification 

Two notes are played sequentially. Both notes must be provided 

and the interval identified. 

Melodic Identification 

Two notes are played sequentially. The interval must be identified. 

Harmonic Completion 

Two notes are played simultaneously. One note is given. The other 

must be provided. 

Harmonic Completion with Identification 

Two notes are played simultaneously. One note is given. The other 

note must be provided and the interval identified. 

Harmonic Notation 

Two notes are played simultaneously. Both notes must be provided. 

Harmonic Notation with Identification 

Two notes are played simultaneously. Both notes must be provided 

and the interval identified. 

Harmonic Identification 

Two notes are played simultaneously. The interval must be 

identified. 

Written 

There is no playback. The first note is given. The Announcements 

and Instructions pane indicates whether the second note is to be 

written above or below the given note, while the Interval ID pane 

indicates the interval that is to be written. 

Visual Identification 

There is no playback. Both notes are given. The interval must be 
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identified. 
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XVII. All Commands 

Open Exercise 

What it does 

Opens an exercise which has been selected in the Drive View pane. 

How to access it 

Menu 

File Menu | Open Exercise, or the Drive View pane Context Menu. 

Keyboard 

Control+O 

Show Progress Report… 

What it does 

Displays the Progress Report dialog box, enabling the viewing, 

managing, printing, and exporting of the current user’s progress 

report. 

How to access it 

Menu 

File Menu | Show Progress Report… 

Keyboard 

Control+P 

Toolbar 
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Options… 

What it does 

Displays the Options Property Sheet, which enables the setting of 

screen colors, the duration of the tonic triad, and the speed of tonic 

pitches. 

How to access it 

Menu 

File Menu | Options… 

Exit 

What it does 

Exits the application. 

How to access it 

Menu 

File Menu | Exit, or click on the Close icon, or use the Control Menu 

and select Close. 

Keyboard 

ALT+F4 

View Toolbar 

What it does 

Shows or hides the Toolbar. The command is a toggle, showing the 

Toolbar if it is hidden, and vice-versa. 

How to access it 

Menu 

View Menu | Toolbar 
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View Status Bar 

What it does 

Shows or hides the Status Bar. The command is a toggle, showing 

the Status Bar if it is hidden, and vice-versa. 

How to access it 

Menu 

View Menu | Status Bar 

New Interval 

What it does 

Presents the next interval in the set of exercise intervals. 

How to access it 

Menu 

Interval Menu | New Interval, or from the Context Menu. 

Keyboard 

Control+N 

Toolbar 

 

Identify Interval 

What it does 

Presents the Identify Interval dialog box, from which the size and 

quality of the target interval are established. 
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How to access it 

Menu 

Interval Menu | Identify Interval, or use the Context Menu. 

Keyboard 

Control+I 

Toolbar 

 

Enter Note 

What it does 

Enters a note into the user-notation pane at the current caret 

position. 

How to access it 

Menu 

Interval Menu | Enter Note, or use the Context Menu. 

Keyboard 

Enter key 

Toolbar 

 

Delete Note 

What it does 

Erases the currently-selected note in the user-notation pane. 
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How to access it 

Menu 

Interval Menu | Delete Note, or use the Context Menu. 

Keyboard 

Backspace key 

Toolbar 

 

Flat Note 

What it does 

Flats the currently selected note in the user-notation pane. 

How to access it 

Menu 

Interval Menu | Flat Note, or use the Context Menu. 

Keyboard 

F7 

Toolbar 

 

Sharp Note 

What it does 

Sharps the currently selected note in the user-notation pane. 
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How to access it 

Menu 

Interval Menu | Sharp Note, or use the Context Menu. 

Keyboard 

F8 

Toolbar 

 

Move Note Up 

What it does 

Moves the currently selected note upwards by one line or space and 

also moves the selection caret upwards by the same amount. 

How to access it 

Menu 

Interval Menu | Move Note Up, or use the Context Menu. 

Keyboard 

Control+Up Arrow 

Toolbar 

 

Move Note Down 

What it does 

Moves the currently selected note downwards by one line or space 

and also moves the selection caret downwards by the same 

amount. 
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How to access it 

Menu 

Interval Menu | Move Note Down, or use the Context Menu. 

Keyboard 

Control+Down Arrow 

Toolbar 

 

Answer Ready 

What it does 

Signifies that the current interval is ready to be evaluated. 

How to access it 

Menu 

Interval Menu | Answer Ready, or use the Context Menu. 

Keyboard 

F5 

Toolbar 

 

Stop 

What it does 

Stops the current exercise before the last interval has been 

reached. 
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How to access it 

Menu 

Interval Menu | Stop, or use the Context Menu 

Keyboard 

Control+X 

Toolbar 

 

Play Interval 

What it does 

Plays the current interval. 

How to access it 

Menu 

Playback Menu | Play Interval 

Keyboard 

Spacebar 

Toolbar 

 

Play My Interval 

What it does 

Plays the user-notated interval. 
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How to access it 

Menu 

Playback Menu | Play My Interval 

Keyboard 

Control+Spacebar 

Toolbar 

 

Play Tonic Triad 

What it does 

Plays the tonic triad in the current key. 

How to access it 

Menu 

Playback Menu | Play Tonic Triad 

Keyboard 

Control+T 

Toolbar 

 

Play Tonic Pitches 

What it does 

Plays three tonic pitches, one octave apart, in the current key. 
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How to access it 

Menu 

Playback Menu | Play Tonic Pitches 

Keyboard 

Control+H 

Toolbar 

 

MIDI Settings… 

What it does 

Displays the MIDI Settings dialog box, from which MIDI output 

port, input port, program channels, and MIDI thru can be adjusted. 

How to access it 

Menu 

Playback Menu | MIDI Settings 

Tempo… 

What it does 

Displays the Set Tempo dialog box, from which the playback tempo 

for intervals can be adjusted. 

How to access it 

Menu 

Playback Menu | Tempo 

Keyboard 

Control+E 
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Help Topics 

What it does 

Presents the Help Topics dialog box, the doorway to the online help 

system. 

How to access it 

Menu 

Help Menu | Help Topics 

Keyboard 

F1 

About Kapelle Intervals… 

What it does 

Displays the About Kapelle Intervals dialog box with information 

about the application. 

How to access it 

Menu 

Help Menu | About Kapelle Intervals 
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XVIII. Keyboard Accelerators 

 

Command Keyboard Accelerator 

Caret Down Down Arrow 

Caret Left Left Arrow 

Caret Right Right Arrow 

Caret Up Up Arrow 

Delete Note Backspace 

Enter Note Enter 

Flat Note F7 

Identify Interval Control+I 

Move Note Down Control+Down Arrow 

Move Note Up Control+Up Arrow 

New Interval Control+N 

Play Interval Spacebar 

Play My Interval Control+Spacebar 

Play Tonic Pitches Control+H 

Play Tonic Triad Control+T 

Sharp Note F8 

Show Progress Report… Control+P 

Stop Exercise Control+X 

Tempo… Control+E 
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XIX. System Requirements 

Kapelle Intervals is a 32-bit Windows application and will run only 

under a 32-bit Windows operating system. It has been tested for 

reliable operation on the following platforms: 

• Windows 95 

• Windows NT 3.51 

• Windows NT 4.0 

• Windows 98 

Kapelle Intervals will not run under the following operating 

systems: 

• Any 16-bit version of Windows (such as Windows 3.1) 

• Windows for Workgroups 3.11 

• OS/2 Warp 3.0 or 4.0 

Kapelle Intervals has not been tested under any of the Windows 

emulators, such as SoftWindows for the Macintosh or UNIX 

systems. 

Kapelle Intervals is not generally processor intensive, and can run 

adequately on any computer system that is capable of running any 

of the supported operating systems. On minimal hardware, very 

large or complex exercises might take up to a minute or two to be 

generated. 

In order to hear any sound with Kapelle Intervals, your computer 

should contain either a Windows-compatible MIDI interface, or a 

sound card with a built-in MIDI interface. Since Kapelle Intervals 

communicates with the MIDI hardware via the Windows multimedia 

interface, any sound card/MIDI interface which works correctly with 

Windows should work with Kapelle Intervals. 
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Play Tonic Triad command, 18, 31, 69 

playback 

interval, 29 

intervals, 15 

MIDI settings, 46 

notated interval, 29 

playing notated interval, 20 

tempo, 30 

tonic pitches, 18, 32 

tonic triad, 18, 31 

Playback Menu, 6 
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